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Pengenalan Website

1. Definisi Website

Sebuah website, atau dikenal juga dengan situs web, adalah sekumpulan halaman web
yang ditampilkan dalam sebuah domain. Website disimpan di dalam server hosting yang
dapat diakses lewat jaringan seperti jaringan Internet atau lewat jaringan area lokal lewat
alamat Internet yang juga dikenal dengan nama Uniform Resource Locator (URL). Website
yang dapat diakses tersebut secara kolektif disebut World Wide Web (WWW).

Halaman web merupakan dokumen berisi teks yang ditulis (paling sederhana) dalam format
Hyper Text Markup Language (HTML). Halaman web dapat memanggil elemen-elemen lain yang

biasa ditampilkan dalam sebuah web, seperti elemen gambar, video, dan sebagainya.
2. Bagaimana Sebuah Website Dapat Diakses

Website diakses melalui Hyper Text Transfer Protocol (HTTP) atau melalui HTTP
Secure (HTTPS) yang merupakan jalur terenkripsi untuk memberikan keamanan
dan privasi bagi konten website. Peramban (browser) adalah alat yang digunakan
pengguna untuk mengakses halaman web yang disimpan di server hosting.

Ketika pengguna mengakses internet melalui browser, browser tersebut akan mengirimkan
sebuah HTTP request. Request tersebut terhubung ke web server melalui Internet Service
Provider (jasa penyediaan akses internet). Beberapa ISP yang dikenal di Indonesia di antaranya

adalah Telkom Speedy, Telkomsel, Indosat, dan lain-lain.
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Berbeda dengan mengakses laman, untuk mengakses file yang terdapat di web
server, protokol yang digunakan adalah File Transfer Protocol (FTP).

3. Jenis Website

A. Statis

Website statis merupakan website yang halamannya harus diedit secara manual untuk

proses perubahan konten. Biasanya laman web statis menggunakan format HTML. Website



statis memberikan informasi yang sama kepada semua pengunjung web. Sama
halnya seperti brosur atau pamflet, website statis memberikan informasi yang
konsisten dan standar untuk periode yang lama

B. Dinamis

Website dinamis adalah website yang secara spesifik dirancang agar konten
dan laman yang terdapat dalam website tersebut dapat diperbarui atau diubah
secara berkala, mudah, dan otomatis.

Format laman web dinamis ditulis dalam bahasa skrip, diantaranya adalah PHP, ASP,
dan lainya. Selain itu, konten website tidak disimpan langsung di laman webnya, akan
tetapi disimpan di sebuah server basis data (database). Data tersebut ditampikan
dalam laman web dinamis dengan menggunakan bahasa skrip.

4. Kapan Website Harus Digunakan

Di jaman teknologi informasi seperti sekarang, distribusi informasi merupakan hal
yang sangat penting bagi keberlangsungan sebuah lembaga. Jika lembaga Anda
berhubungan dengan publik dan sangat penting bagi lembaga tersebut untuk
memberi informasi secara langsung, maka di saat itulah website perlu digunakan.

Karena informasi memiliki berbagai macam bentuk dan kapasitas, maka penggunaan
website harus sesuai dengan tujuannya terlebih dahulu. Target pengunjung pun
penting sebagai pertimbangan akan dibuat seperti apa website tersebut.

5. Tujuan Pengadaan Website

Hal yang perlu ditentukan sebelum ke langkah pembangunan website adalah
tujuan yang jelas untuk apa website itu dibuat. Karena keberagaman fungsi
website, maka setiap tujuan pasti ada teknik pembuatan yang berbeda, walaupun
pada kenyataanya bisa saja pembuatan website memiliki beberapa tujuan.

A. Company Profile

Ketika sebuah institusi ingin diperkenalkan kepada publik, maka jenis website
yang paling tepat adalah pembuatan website company profile. Website
company profile berisi informasi menyeluruh tentang institusi tersebut, mulai
dari sejarah lembaga, kontak, visi dan misi, identitas, serta struktur institusi.
Kebanyakan laman dari website ini berjenis laman statis.
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B. Portal Berita

Website yang bertujuan sebagai portal berita biasanya memiliki sirkulasi
konten yang sangat dinamis. Di laman depan website ini langsung terlihat
kumpulan berita yang terkategorikan dan menu navigasi, sehingga
memudahkan pengunjung untuk menentukan konten yang mereka cari.
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C. Commerce

Website e-commerce bertujuan untuk kepentingan komersial seperti menjual
produk, baik produk hardware maupun software. Ciri paling jelas web tersebut
adalah adanya galeri produk yang akan dijual serta proses pembayaran yang
dapat langsung diproses secara online.
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D. Blog

Weblog atau biasa disebut blog merupakan website yang berisi tulisan (biasanya
berbentuk tulisan naratif) yang disusun secara kronologis diurutkan dari artikel yang
paling baru. Blog biasanya lebih bersifat pribadi yang diisi oleh seseorang. Karena
konten utama dari blog adalah tulisan naratif tersebut, biasanya laman depan blog
langsung berisi konten tersebut, dilengkapi dengan sidebar yang berisi arsip tulisan.
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E. Aplikasi berbasis web
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Website yang berupa aplikasi adalah website yang bertujuan khusus untuk mengolah
data atau kebutuhan spesifik lainnya. Contoh dari aplikasi berbasis web adalah
layanan email berbasis web, layanan kemahasiswaan, atau layanan registrasi.



() UNIVERSITAS PADJADJARAN

PACIS students.unpad.ac.id

Sebelum melanjutkan, silahkan login terlebih dahulu melalui PAuS!

Padjadjaran Authentication System atau yang di sebut PAuS adalah identitas unik yang
wajib dimiliki oleh pengguna jaringan komputer di Universitas Padjadjaran. Untuk
mendapatkan akun PAuS, pengguna baik Mahasiswa, Staff, dan Dosen diwajibkan
melakukan registrasi.

Setelah anda melakukan login, maka akan di redirect ke :
PACIS students.unpad.ac.id

PAuUS Name

Password

Login

Informasi Lebih Lanjut :

Helpdesk DCISTEM

Bandung : Gedung 2 Lt.5 Jl. Dipati Ukur No.3S, Bandung.

. JL.Raya Jatinagor Km. 21 (Ruang Layanan Terpadu Gd. Rektorat Lt. 1

“Telp.022-84288888 ext.1888

Email : studentsupport@unpad.ac.id (untuk mahasiswa)
support@unpad.ac.id (untuk staff/dosen)

Jatinangor

Technical Support
http://support.unpad.ac.id




Pengembangan Website

Hosting
A. Local Hosting

Sebelum web dipublikasikan ke luar, sebaiknya dalam tahap awal web yang
sedang dikembangkan tidak disimpan di server yang tersambung ke internet.
Maka, solusinya adalah membuat komputer pribadi kita sebagai server lokal.
Untuk dapat membuat komputer menjadi sebuah server lokal dibutuhkan
aplikasi seperti XAMPP (untuk Windows) atau MAMP (untuk Mac).

Setelah proses instalasi XAMPP, jalankan dua service yang diperlukan sebuah website, yaitu
service Apache dan MySQL. Apache merupakan aplikasi yang berjalan secara background (atau
disebut juga service) di dalam sistem operasi sebagai server untuk keperluan local hosting,

sedangkan MySQL adalah service yang berjalan untuk keperluan database.

JF config_|
Sn(A:g:;c:zs Module  PID(s) Port(s) Actions
Apache ([ stat || Admin | [ Config | [ Logs |

- FileZilla [ stan ] [ Admin | [Config | [ Logs | [ B Senices |

PM [main] Initializing Control Panel
[main] Windows Version: Windows 7 Home Premium SP1 64-bit
[main] XAMPP Version: 1.8.1
[main] Control Panel Version: 3.1.0 3.1.0 [ Compiled: September 20th 2012 ]
[main] Running with Administrator rights - good!
[main] XAMPP Installation Directory: "c:\xampp\"
[main] Checking for prerequisites
[main] All prerequisites found
[main] Initializing Modules
[main] Starting Check-Timer
[main] Control Panel Ready

Lokasi folder hosting ada di folder bernama ‘htdocs’, atau secara settingan instalasi

default ada di c:\xampp\htdocs. Di folder itulah kita akan menyimpan file web.

B. Web Hosting

Jika web yang berada di local hosting sudah siap dipublikasikan ke internet, file web yang
ada di folder ‘htdocs’ dapat diunggah ke web hosting. Web hosting memanfaatkan sebuah

server yang dapat diakses oleh seluruh dunia lewat Internet. Untuk dapat mengakses web



hosting, pengguna harus memiliki akses CPanel (laman konfigurasi server),
akses FTP, dan akses database.

Untuk dapat mengakses web hosting, perlu aplikasi FTP client. FTP client yang
paling umum dipakai adalah FileZilla.

E SourceForge - sftp://critternyc@frs.sourceforge.net - FileZilla ﬂlﬂ_hj
File Edit View Transfer Server Bookmarks Help
M-I S v B e | E 1)
ol B 2 > - = LA
CLOFE] 2 v Bk & |5 ¢
Response: New directory is: “/home/pfs/project/p/po/portableapps/FileZilla Portable FileZilla Portable 3.2,7,1" ~
Command: Is
Status: Listing directory /home /pfs/project/p/po/portableapps/FileZila PortableFileZila Portable 3.2.7.1
Status: Directory listing successful -~
Local site: | D:\Development'Portable Apps\FileZilla\Releases v | Remote site: J \/po/portableapps/FileZilla Portable/FileZila Portable 3.2.7.1 +
& EverNote A 2 FileZilla Portable 3.2.6 P
= FileZilla i 2 FileZilla Portable 3.2.6.1 L
Assets 2 FileZilla Portable 3.2.7 <l
IS Releases ~ |« il | »
Filename / Filesize ~ Filetype La | Filename / Filesize
Archive File Folder 9/, | @7 FileZillaPortable_3.2.7.1.paf.exe 4,361,088
& FileZillaPortable_3.2.7.1.paf.exe 4,361,088 Application 8/.
] it - v | [ [ix
1 file and 1 directory. Total size: 4,361,088 bytes 1 file. Total size: 4,361,088 bytes
Server/Local file Direction ~ Remote file
< m | »
Queued files | Failed transfers Successful transfers
a8 Queue: empty e

Untuk menambahkan situs yang dikelola, pertama-tama tuju menu File > Site
Manager. Setelah itu, pilih New Site karena kita akan membuat situs baru. Isikan
host, username dan password FTP, kemudian pilih Connect. Apabila semua data
tersebut diisi dengan benar, maka Anda akan berhasil masuk ke web server.

Terdapat dua windows di dalam tampilan utama FileZilla, yang pertama yaitu Local site
di sebelah kiri dan Remote site di sebelah kanan. Window Local site menampilkan data
yang terdapat di komputer yang sedang digunakan, sedangkan window Remote site
menampilkan data yang ada pada server yang sedang terkoneksi. Untuk memindahkan
file dari Local site ke Remote site, secara sederhana cukup drag and drop saja.

2. Database

Database atau basis data merupakan kumpulan data yang terstruktur dan berrelasi yang
disimpan di dalam sebuah komputer atau server. Dalam pembangunan website yang dinamis,
tidak cukup hanya memanfaatkan laman web bertipe HTML saja. Diperlukan adanya

implementasi database untuk menyimpan data yang akan diakses oleh laman web. Data
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tersebut bisa berbagai macam, namun kebanyakan data yang disimpan di database
merupakan data berbentuk string/teks.

Untuk membuat database di dalam sebuah hosting, biasanya server hosting telah
menyediakan aplikasi untuk mengelola database bernama PHPMyAdmin. Aplikasi
tersebut bisa diakses di http://[[yourdomain]/phpmyadmin.

FireTon > = @]ﬂ
},‘,m demo.phpmyadmin.net / phpMyAd... * I'JﬁleHorse.com/FreeSoftware Downl... | for \ -
(- & demo.phpmyadmin.net/master-config/ZPMAURL-1:db_structure.php?db=phpmyadmin8itable=&es c E' FileHorse.com P ¥ A B~
i \dn 'l‘i n i‘i: T phpiiyAdmin demo - MySQL » 8 phpmyadmin Z
RO ) 4 Structure | L[ SQL 4 Search 4l Query | Export = Import ¥ More
Current Server: Table = Action Rows Type Col
phpMyAdmin demo - le L
(Recenttables) B [[] pma__bookmark =| Browse 4 Structure % Search % Insert fg Empty @ Drop o MylSAM wutfg
] pma_ column_info =] Browse s Structure % Search ¥¢ Insert §gl Empty @ Drop 38 MyISAM wutf8
fiter databases byname X - § =
= [[] pma__designer_coords || Browse 34 Structure & Search % Insert g Empty @ Drop 0 MyISAM utfg
[ 1 {Z] >335 =
%~ 7 alumno10 3 [7] pma__history | Browse 4 Structure % Search ¥ Insert il Empty @ Drop 9 MyISAM  utf8)
1[-— s g [[] pma__pdf pages Browse 4 Structure % Search #¢ Insert i Empty @ Dro 9 MylSAM utfg
) e 3 0
-G alumnos04 pma__pdl_pag = # * ¥ p p yl
ds alumnos1 [ pma__recent ] Browse f Structure 4 Search 3¢ Insert g Empty @ Drop 1 MyISAM utfg
g€ alumnos2
ol alumnos 2 [[] pma__relation ] Browse 4 Structure % Search ¥ Insert §g Empty @ Drop 1 MyISAM utfg
% alumnos?
i_ alumnos50 [7] pma__table coords =| Browse 4 Structure & Search Fc Insert gl Empty @ Drop o MyISAM utfg
i
*+-4 fun = =
3 = - y : a g
‘-L-— ) information, schéma [[] pma__table_info =] Browse 4 Structure & Search Fc Insert % Empty @ Drop MyISAM  utfs
Bt
*1y Leon_Sales [7] pma__table_uiprefs =] Browse: # Structure & Search ¥¢ Insert §§l Empty @ Drop 1 MylSAM utf3
‘T"' menagerie
+— 4 mysql [[] pma__tracking =| Browse 4 Structure % Search % Insert §g Empty @ Drop o MylSAM utfg
e - opengis = . .t
- phpmyadmin [] pma__userconfig | Browse Jx Structure % Search ¢ Insert fg Empty @ Drop 9 MyISAM utf8
-
T S pore. 12 tables Sum 41 InnoDB utft
T_’ practica
[#— Raport §
1 - :
[# - 1| Rebeccahommusic.com ;3 4+ [EICheck All / Check tables having overhead With selected E[ -
B & L
< T »

3. Elemen Dasar

Web A. Header

Header di dalam laman website sebenarnya merujuk kepada dua hal yang
berbeda. Header yang pertama adalah header laman website (user interface)

dan yang kedua adalah header dokumen web.

Header laman website merupakan bagian paling atas sebuah laman web yang
berisi judul website, logo, dan navigasi. Dalam sebuah website, secara statis
header selalu ada di tiap lamannya.
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Tracer Study

PEMBELAJARAN PENELITIAN & PENGABDIAN KEUANGAN

Jika dilihat dari kode HTML-nya, beberapa metadata terletak di dalam
bagian header dokumen <HEAD>, yaitu

<title> Judul laman

<meta name="description”> Rangkuman tentang isi dokumen

<meta name="keyword”> Kata kunci yang ada dalam dokumen

<meta charset="UTF-8"”> Character Encoding Standard atau Character Set
<link rel="stylesheet> Alamat dokumen stylesheet (CSS)

<meta name="viewport”> Mengecek ukuran layar yang digunakan

"o o0 o

B. Content Section

Content section menampung isi utama dari laman yang dibuka. Misalnya, jika di laman
awal (index) sebuah website, content section akan berisi daftar artikel yang tersedia di
website tersebut. Akan tetapi, bila laman artikel/post yang dibuka, content section
akan menampilkan isi dari sebuah artikel. Pada umumnya, content section berisi judul
artikel, tanggal publikasi artikel, penulis artikel, isi artikel, kategori, dan kata kunci.

12
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Pertumbuhan Sektor
Agroindustri Belum Optimal

C. Sidebar

Sidebar adalah kolom sekunder yang ada di laman web selain kolom konten utama.
Biasanya posisi sidebar ada di samping content section. Dalam sebuah laman web, sidebar
bisa berada satu hingga dua, bisa di kedua sisi atau salah satu sisi. Di dalam sidebar kita

bisa melihat menu navigasi atau fitur lain seperti tautan, artikel terbaru, atau teks biasa.

EwGLIS™ PETA STUS AL RSP
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D. Footer

Footer adalah bagian akhir dari laman web dan terletak di paling bawah. Sama halnya
seperti header, footer bersifat statis; setiap laman memiliki footer yang sama. Hal-hal
umum yang ada di dalam footer adalah keterangan hak cipta dan alamat organisasi.

TAUTAN MEDIA SOSIAL

Bahasa Pemrograman Web
A. Hyper Text Markup Language (HTML)

HTML adalah sebuah bahasa markup standar yang digunakan untuk membuat
laman web. HTML berisi elemen-elemen yang berbentuk tags ditutupi oleh
tanda kurung siku-siku. Umumnya tag tersebut berpasangan, seperti <h1> dan
</h1>, namun ada juga yang tidak berpasangan, seperti <img>.

Struktur standar sebuah laman web dapat dijabarkan seperti di bawah ini:
<html|>
<head>
<title>Judul Laman</title>
</head>
<body>
<h1l>Heading 1</h1>
<p>Paragraf</p>
</body>

</html>

14



Hingga kini, perkembangan HTML sudah mencapai HTML5. Beberapa fitur penting

yang terdapat dalam HTML5 adalah adanya dukungan untuk pemutar video dan audio.
B. PHP

PHP merupakan bahasa pemrograman server-side yang digunakan untuk
pengembangan aplikasi web. PHP biasanya digunakan bersama-sama dengan HTML.
Untuk menjalankan PHP, sebuah server harus dipasang sebuah PHP Interpreter.

Contoh skrip PHP:
<html|>
<head>
<title>PHP Test</title>
</head>
<body>
<?php echo '<p>Hello World</p>'; ?>
</body>
</html>
C. Javascript

Javascript merupakan bahasa pemrograman client-side yang diproses di
peramban. Javascript dapat berinteraksi langsung dengan pengguna,
mengendalikan peramban, hingga mengubah dokumen yang tampil di peramban.

Contoh Javascript:
<script type="text/javascript">
alert("Hello World!");
</script>
5. Perlengkapan untuk Pembuatan Website

Perlengkapan esensial untuk membuat sebuah website sebenarnya cukup editor teks dan

pengolah grafis. Namun dalam perkembangannya, beberapa aplikasi dilengkapi dengan fitur

15



tambahan, seperti fitur untuk melihat hasil coding seperti yang ada di dalam
aplikasi Dreamweaver.

Beberapa editor teks yang umum digunakan di antaranya:

g. Sublime Text
h. Notepad++
i. PHP Edit

Sedangkan pengolah grafis yang umum digunakan di antaranya:

a. Adobe Photoshop
b. Adobe Illlustrator
c. Corel Draw

d. GIMP

6. Pemilihan CMS

Content Management System atau yang biasa disingkat CMS adalah program website yang
menginjinkan pengguna untuk mempublikasikan, mengedit dan memodifikasi content website
dan dapat mengatur maintenance dari pusat antar muka sebuah website. Biasanya CMS ini

digunakan dalam tipe content website portal, blog, shop, dan jenis tipe content lainnya.

Ada banyak CMS script yang digunakan dalam membuat suatu website. Namun dalam
memilih sebuah CMS terdapat beberapa hal yang harus diperhatikan seperti:

Apakah CMS yang akan digunakan sesuai dengan kebutuhan

Apa yang Anda harapkan dari website yang Anda buat? Hanya untuk menulis saja
atau dibutuhkan pula kolom widget yang beragam. Apakah CMS tersebut cocok
untuk news portal, blogging, atau online shopping.

Apakah web hosting yang akan digunakan mendukung CMS tersebut

Perlu diperhatikan apakah web hosting yang Anda gunakan mendukung database
MySQL? Apakah versi PHP yang digunakan memenuhi CMS script yang Anda
gunakan? Apakah Gd-Library mendukung image manipulation, dan lain-lain.

Apakah CMS yang akan digunakan sesuai dengan koneksi internet Anda

Jika Anda menggunakan CMS yang memiliki banyak fasilitas (menggunakan Ajax sehingga
lebih mirip dengan aplikasi desktop) sehingga waktu loadingnya lama. Perlu diperhatikan
apakah koneksi internet Anda mampu mengakses website tersebut secara maksimal.
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Apakah CMS yang akan digunakan mendukung SEF (Search Engine Friendly)

SEF ini sangat dibutuhkan agar situs pencarian seperti google mengindeks website Anda.

Apakah CMS yang akan digunakan mendukung RSS (Rich Site Summary)

Saat ini RSS sudah menjadi menu wajib, tidak hanya di kalangan website populer tapi juga di
kalangan website blog. Umumnya RSS digunakan secara luas untuk menyebar ringkasan tulisan

terbaru, kadang-kadang juga menyertakan artikel lengkap dan bahkan gambar dan suara.
Apakah CMS yang akan digunakan mendukung pembagian kategori

Agar pengunjung website Anda mudah membaca isi website yang Anda buat, lebih mudah

jika membaca tulisan yang dikategorikan dengan baik daripada tercamput menjadi satu.
Apakah CMS yang akan digunakan mendukung sitemap dan Google sitemap

Sitemap sebenarnya mempermudah pengunjung untuk menelusuri website Anda, akan
tetapi sitemap ini juga mempermudah google bot dalam mengindeks website Anda.
Apabila CMS kita mendukung Google sitemap, maka hal tersebut akan sangat membantu.

Berikut review dari beberapa CMS yang sangat populer digunakan seperti
Wordpress, Joomla, dan Drupal.

Joomla, and
Drupal

Wordpress Joomla Drupal
Released in 2003 by Matt Released in 2005, forked Released in 2001 by Dries
Mullenwegg from Mambo Buytaert
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a. Wordpress

Website: http://www.wordpress.org

Popularitas: 140 juta pengguna

Biaya: Gratis

Tema gratis yang tersedia: 2.000+

Plugin gratis yang tersedia: 27.000+

One click installation availibility: Ya

SEF: Ya

Waktu yang dibutuhkan untuk instalasi manual: 5 menit

Cocok digunakan untuk: blogs, corporate websites, small-medium sized websites

Website populer yang menggunakan Wordpress: forbes, CNN, Sony
b. Joomla

Website: http://www.joomla.org

Popularitas: 30 juta pengguna

Biaya: Gratis

Tema gratis yang tersedia: 900+

Plugin gratis yang tersedia: 7.000+

One click installation availibility: Ya

SEF: Ya

Waktu yang dibutuhkan untuk instalasi manual: 10 menit

Cocok digunakan untuk: e-commerce, social network sites

Website populer yang menggunakan Joomla: Harvard University, The Hill
c. Drupal

Website: http://www.drupal.org

Popularitas: 15 juta pengguna

Biaya: Gratis

Tema gratis yang tersedia: 1.800+

Plugin gratis yang tersedia: 24.000+

One click installation availibility: Ya

SEF: Ya

Waktu yang dibutuhkan untuk instalasi manual: 10 menit

Cocok digunakan untuk: one size fits all

website populer yang menggunakan Drupal: Linux, The White House
Washington, Warner Bros
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7. Instalasi WordPress
Berikut adalah langkah-langkah untuk instalasi WordPress di web hosting

1. Unduh file instalasi WordPress terbaru di http://wordpress.org.

2. Ekstrak file zip yang telah diunduh.

3. Unggah file yang telah diekstrak ke web hosting.

a. Jika Andaingin WordPress dipasang di root domain (misalnya
http://yourdomain.com), maka upload ke direktori root web hosting.

b. Jika Andaingin WordPress dipasang di direktori lain (misalnya
http://lyourdomain.com/blog), maka upload ke direktori ‘blog’ tersebut.

4. Buat database untuk keperluan web melalui PHPMyAdmin. Dalam contoh ini
misalnya nama database yang kita buat adalah ‘basisdata_cms’ dengan nama
user ‘webuserdb1’ dan password ‘webpassdb1’

5. Untuk menjalankan instalasi WordPress, akses URL webnya menggunakan
peramban. URL tersebut adalah URL tempat Anda mengunggah file
WordPress. Jika berhasil, seharusnya web menampilkan tampilan seperti ini:

Ay el

Azarbaycan dili
Bbnrapcku
Bosanski

Catala

Cymraeg

Dansk

Deutsch (Schweiz)
Deutsch

EAANnvika

English (UK)
English (Australia)
English (Canada)
c

Anaranba

English (United States) H

Pilih bahasa yang akan dipakai kemudian tekan ‘Continue’
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6. Isi keterangan koneksi database sesuai dengan yang telah dibuat.

Below you should enter your database connection details. If you're not sure about these, contact your host.

Database Name basisdata_cms The name of the database you want to run
WP in.

User Name webuserdb1 Your MySQL username

Password webpassdb1 ...and your MySQL password.

Database Host localhost You should be able to get this info from

your web host, if localhost does not work.

Table Prefix [ pelatihan[_ If you want to run multiple WordPress
installations in a single database, change
this.

Submit

7. Apabila berhasil terkoneksi dengan database, maka akan keluar tampilan seperti ini:

All right, sparky! You've made it through this part of the installation. WordPress can now communicate with
your database. If you are ready, time now to...

Run the install



8. Isi keterangan umum website, kemudian ‘Install WordPress’

Welcome

Welcome to the famous five-minute WordPress installation process! Just fill in the information below and
you'll be on your way to using the most extendable and powerful personal publishing platform in the world.

Information needed

Please provide the following information. Don’t worry, you can always change these settings later.

Site Title

Username

Usernames can have only alphanumeric characters, spaces, underscores, hyphens, periods, and the
@ symbol.

Password, twice

A password will be

automatically generated

for you if you leave this

blank. Strength indicator

Hint: The password should be at least seven characters long. To make it stronger, use upper and
lower case letters, numbers, and symbols like ! " 7§ % A &),

Your E-mail

Double-check your email address before continuing.

Privacy @ Allow search engines to index this site.

Install WordPress

9. Setelah proses instalasi selesai, login menggunakan akun yang tadi didaftarkan.
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Pengelolaan dan Perawatan Website

Tahap berikut setelah pembuatan adalah pengelolaan dan perawatan website.
Perlu diketahui bahwa pengelolaan dan perawatan merupakan proses paling sulit
dan paling panjang, karena melibatkan banyak orang dan kemampuan.

1. Manajemen Konten

Dalam sebuah website, apalagi sebuah portal berita, perlu adanya manajemen konten
yang baik. Tujuan dari manajemen tersebut adalah agar konten mudah dicari dengan
menggunakan perangkat navigasi website dan terstruktur dengan rapi.

A. Penentuan Penggunaan Post dan Page

Dalam WordPress, konten dapat dibagi ke dalam dua bentuk: Post dan Page. Post adalah
konten yang bersifat dinamis dan selalu diperbarui dengan cepat, misalnya konten berita.

Post bersifat kronologis (terikat dengan waktu) karena sifat keterbaruannya.

Sedangkan Page adalah konten yang tidak terikat oleh waktu, maka disebut
juga konten statis. Page tidak memiliki kategori atau pun tag. Namun, Page
dapat memiliki sub page. Berikut adalah contoh struktur laman web:

[ Profi [ Kontak ] _ [Karya limiah ]
_{ Sejarah Buku ]
— Identitas J f Jumal ]

_[ Misi ]

B. Kategorisasi

Untuk mengelola kontent Post, gunakanlah sistem kategori. Kategorisasi berguna
untuk mengelompokkan beberapa Post atau memberi tahu tentang apa Post tersebut
kepada pembaca. Post dapat dimasukkan ke dalam sebuah (atau beberapa) kategori
dan subkategori. Daftar kategori dapat diletakkan di menu navigasi dan sidebar.
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_| Berita | Agenda | _ Pengumuman]
)
Kemahasiswaan Mahasiswa '

S

— Profil Alumni
S —

C. Tag

Tag adalah kata kunci yang ada di dalam konten. Penggunaan tag mirip fungsi kata kunci
yang ada dalam abstrak karya tulis. Tag berfungsi agar pencarian konten berbasis kata
kunci lebih mudah digunakan. Tag pun bersifat SEO friendly, yang berarti kata kunci yang

ada di artikel akan menjadi kata kunci yang digunakan oleh mesin pencari juga.
2. Manajemen Pengelola

Pengelolaan website membutuhkan beberapa orang yang terbagi dalam minimal
tiga posisi utama, yaitu Web Designer, Administrator, dan Content Editor.

Web Designer bertugas untuk merancang visualisasi website dan biasanya
merangkap sebagai desainer grafis untuk konten.
Administrator bertugas untuk mengurus hosting dan keperluan administrasi
web seperti penambahan user dan penambahan fitur.

Content Editor bertugas untuk mengelola konten.

Di dalam situs yang memiliki sirkulasi konten yang sangat dinamis, tugas Content
Editor terbagi lagi ke dalam beberapa bagian, yaitu:

a. Editor: seseorang yang berwenang untuk mempublikasikan dan mengatur
artikel-artikel termasuk artikel yang ditulis oleh user lain.

b. Author: seseorang yang dapat mempublikasikan dan mengatur artikel yang
dia tulis sendiri.

c. Contributor: seseorang yang dapat menulis dan mengatur tulisannya sendiri
namun tidak sampai mempublikasikannya (hanya sampai tahap draft).

Level-level pengelola Administrator dan Content Editor dapat diatur di dalam
WordPress dengan mengakses Dashboard > Users.
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3.

Plugin

Plugin merupakan aplikasi tambahan yang dapat dipasangkan di WordPress. Kebanyakan plugin

dikembangkan oleh pengembang third-party. Alasan mengapa diperlukan plugin adalah karena fitur

awal yang disediakan oleh WordPress tidak mencukupi kebutuhan dan permintaan user.

Berikut adalah beberapa plugin esensial yang biasanya diperlukan dalam sebuah website.

4.

A. Statistik Situs

Sebuah website membutuhkan statistik situs untuk memberikan laporan tentang
seberapa banyak website. Umumnya plugin statistik juga memberikan laporan tentang
artikel mana saja yang paling banyak dikunjungi, berapa pengunjung perhari,
perbulan, atau pertahun. Plugin yang sering digunakan adalah JetPack dan Site Stats.
Google Analytics pun dapat digunakan, namun bukan sebagai plugin WordPress.

B. Keamanan

Sebagai CMS yang paling banyak digunakan di seluruh dunia, WordPress sangat
rentan dengan serangan hacker dan spam. Beberapa metode yang dapat digunakan
sebagai langkah pengamanan adalah mematikan form komentar (apabila sebenarnya
tidak terlalu diperlukan). Selain itu, dapat juga menggunakan CAPTCHA untuk
mengecek apakah yang memberi komentar itu seseorang atau sebuah bot. Alternatif
lainnya adalah menggunakan sistem komentar yang disediakan oleh pihak third-party
seperti Disqus yang akan dijelaskan di bagian selanjutnya.

Serangan lazim yang sering terjadi selain spam adalah script injection. Celah script
injection terbuka salah satunya karena penggunaan template atau plugin bajakan atau
yang out of date. Untuk mengecek apakah sebuah website terkena script injection,
gunakan plugin Wordfence yang dapat memindai setiap file yang ada di web.

Tema

Visualisasi dari apa yang kita lihat di dalam laman depan web kita dihasilkan dari tema yang

kita terapkan di dalam WordPress. Tema WordPress mengatur tampilan antarmuka, layout,

sekaligus fitur apa yang dapat digunakan, karena sebagian tema memiliki fitur yang tertempel.

Beberapa hal yang perlu dipertimbangkan dalam pemilihan tema akan dijelaskan di bawah ini.

A. Warna

Warna sangat berhubungan dengan identitas yang direpresentasikan lewat
web. Beberapa aspek yang perlu diperhatikan saat pemilihan warna adalah:
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Complementation: bagaimana kecocokan antara tiap satu warna dengan

warna yang lain
Contrast: tingkat kontras (perbedaan warna) yang tepat akan membantu kemudahan

membaca (readability), terutama perbedaan warna latar belakang dengan teks.
Vibrancy: Tingkat kecerahan dan kekuataan warna berpengaruh kepada
rasa apa yang ingin ditawarkan ketika membuka laman web. Warna cerah
dan kontras menunjukkan semangat dan biasanya digunakan di dalam
website yang memuat berita tentang remaja. Sedangkan warna-warna yang
kurang kontras biasa digunakan oleh web korporat.

Beberapa industri menyediakan skema warna yang telah dbuat oleh para
desainer, antara lain layanan Adobe Kuler dan Colourlovers.com.

B. Layout

Layout standar sebuah web berisi header, content section, siderbar, dan
footer. Beberapa aspek yang perlu diperhatikan dalam memilih layout adalah:

Berapa kolom yang dibutuh, apakah dua kolom (content-sidebar) atau tiga
kolom (sidebar-content-sidebar) atau bukan di antaranya.
Layout yang memiliki lebar mengikuti layar (fluid) atau yang memiliki lebar
yang tetap (fixed).

Dukungan responsive layout, yaitu layout yang mengikuti besar layar, apakah layar
desktop, mobile, atau tab.

C. Huruf

Huruf pun membawa feel tertentu; apakah ingin formal seperti Times atau ingin
yang lebih minimalis seperti Open Sans atau Helvetica. Huruf sangat berdampak
besar terhadap user experience, karena konten utama sebuah website tentunya
adalah artikel.Yang perlu diperhatikan ketika memilih huruf adalah:

Tingkat keterbacaan (readability), karena ada beberapa jenis huruf yang
sulit untuk dibaca.

Spacing, baik itu antar huruf maupun antar baris.
Ukuran huruf, harus memiliki perbedaan antara Heading 1, Heading 2,
Paragraf, Quote, Emphasize, dan lainnya.
Penggunaan layanan online web font. Karena tidak semua komputer memiliki
font yang harus digunakan di laman web, maka alternatifnya adalah
menggunakan layanan webfont seperti Google Web Font dan TypeKit.
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5.

Backup Website

Alasan website harus dibackup?

Ada 5 asalan mengapa website Anda harus dibackup:

1.

Membackup website bukan merupakan tanggung jawab web hosting

Beberapa layanan web hosting tidak sepenuhnya melayani backup website,
biasanya untuk mendapatkan layanan backup website Anda harus menambah
sejumlah fee pada web hosting yang Anda gunakan.

Menyimpan website Anda di localhost belum cukup!

Jika Anda terbiasa menggunakan mengembangkan website di localhost, Anda mungkin
berpikir hal tersebut sudah cukup. Namun seiring berjalannya waktu, websitenya yang
Anda publish di web server akan terdapat perubahan. Hal ini yang membuat Anda harus

membackup tidak hanya file script website tapi juga isi konten website Anda.
Siap bereaksi dengan cepat

Bayangkan jika website Anda yang usianya sudah panjang, memiliki kualitas SEO
yang baik, pendapatan yang terus mengalir tiba-tiba terkena hack, sedangkan Anda
tidak memiliki backup-an website? Tentu hal tersebut akan sangat merugikan Anda.

Membuat pemilik website merasa tenang

Seperti pada alasan sebelumnya, jika Anda sudah membackup website Anda tidak
perlu lagi mencemaskan website Anda yang terkena hack. Jika hal tersebut terjadi
Anda hanya perlu merestore data website yang sudah Anda backup.

Melindungi website Anda dari serangan virus

Beberapa layanan web hosting sudah memiliki antivirus yang siap melakukan
scanner terhadap website client. Namun tidak semua web host melakukan
scanner terhadap virus dan malware secara proaktif. Oleh karena itu,
sebaiknya anda membackup website agar terhindar dari virus dan malware.
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6. Tips
Berikut adalah tips-tips yang dapat digunakan dalam memaksimalkan kinerja website Anda

A. Format Postingan Website yang Baik

Format postingan merupakan isu penting dalam desain website. Hal ini
menyangkut aspek scannability dan readability. Bagaimana format postingan
website yang baik? Salah satunya adalah menggunakan rata kiri (text align left)!

Perhatikan tampilan postingan website Anda. Apakah tampilan teksnya rata kiri
ataukah rata kiri-kanan (justify)? Jika rata kiri-kanan (justify), sehingga
tampilannya seperti format teks tulisan di koran, buku, atau surat resmi, itu
artinya website Anda menganut ‘aliran resmi-formal’ dan ‘kaku’.

Tampilan posting rata kiri-kanan alias full-justified tidak lazim. Selain membuat
kaku, memperlambat user untuk membacanya, tampilan teks justify ini juga
akan tampak buruk jika ada di kolom sempit.

Sebaliknya, tampilan posting atau teks rata kiri (align-left), akan lebih mudah
dibaca, lebih enak dilihat (dipindai/scanned), dan ini artinya memenuhi aspek
‘readability naskah online’.

B. RataKiri (Text Align Left) atau Rata Kanan Kiri (Justify)

Faktor Readable & Scannable merupakan masalah penting, terkait kenyamanan
user/pengunjung, juga terkait UX (User Experience) dalam membaca tulisan
(teks) di situs website.

Ada tiga alasan utama mengapa naskah posting (tulisan) di website harus rata
kiri (align left), bukan rata kiri-kanan (justify, justified).

1. This makes it easier to read.

Naskah rata kiri lebih mudah dibaca. Lebih nyaman di mata. Lebih
mengesankan rileks, santai, dan tidak kaku!

2. Justified Alignment is actually non-standard for the web.

Rata kiri-kanan (justify) bukan standar website. la standar surat-menyurat,
tulisan ‘serius’ (skripsi atau karya ilmiah).
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3. Bawaannya Rileks!

Rata kiri-kanan (justify) menunjukkan formal, kaku, tidak rileks. Rata kiri (align left)

akan menyisakan ‘ruang putih’ (white space) lebih banyak untuk ‘istirahat mata’.

Selain itu, justify biasanya memunculkan jarak antar kata yang tidak
kompak alias acak-acakan. Lihat contohnya berikut ini. Rata kiri lebih enak
dibaca (readable) alias dipindai (scannable).

ALIGN LEFT (RATA KIRI)

In publishing and graphic design, lorem
ipsum is a filler text commonly used to
demonstrate the graphic elements of a
document or visual presentation.

Replacing meaningful content that
could be distracting with placeholder
text may allow viewers to focus on
graphic aspects such as font,
typography, and page layout.

The lorem ipsum text is typically a
scrambled section of De finibus
bonorum et malorum, a 1st-century BC
Latin text by Cicero, with words altered,
added, and removed such that itis

JUSTIFY (RATA KIRI-KANAN)

In publishing and graphic design, lorem
ipsum is a filler text commonly used to
demonstrate the graphic elements of a
document or visual presentation.
Replacing meaningful content that
could be distracting with placeholder
text may allow viewers to focus on
graphic aspects such as font
typography, and page layout.

The lorem ipsum text is typically a
scrambled section of De finibus
bonorum et malorum, a 1st-century BC
Latin text by Cicero, with words altered,

added, and removed such that it is
nonsensical, improper Latin.

nonsensical, improper Latin.

C. Disqus Sebagai Alternatif Kolom
Komentar Apa itu Disqus?

Disqus merupakan layanan sistem komentar berjaringan di dunia maya,
banyak dari berbagai situs populer yang mengintegrasikan dengan disqus
dengan tujuan untuk mendukung diskusi dengan pengguna di dunia maya.

Dari segi fasilitas dapat dikatakan sangat lengkap dan mudah untuk digunakan,
tidak heran berbagai situs populer menganggap diskusi melalui dunia maya
juga harus diperhitungkan karena media tersebut dapat dikatakan sangat
interaktif internet muncul untuk menawarkan komunikasi satu arah.

Berikut alasan mengapa Disqus dapat menjadi salah satu alternatif layanan
komentar yang dapat Anda terapkan di website yang Anda kelola:
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Anda bisa menyesusaikan model komentar berjalur (threaded comment)
atau yang tipe rata (flat) dengan tetap menyertakan alur diskusi dengan
rapi. Bahkan bisa memaksa mesin blog yang tidak mendukung galur
komentar untuk menampilkan komentar bergalur.

Meningkatkan interaksi sosial antara pemberi tanggapan, karena tidak
menutup diri komunikasi antara penulis dan pengunjung saja.

Dapat memberikan tanggapan dengan menggunakan akun jejaring sosial seperti
facebook, twitter, yahoo dan OpenlID. Jadi tidak hanya narablog yang bisa berinteraksi
dengan membuka potensi jejaring sosial yang dimiliki seorang pengguna internet.
Atau hanya memberi tanggapan sebagai tamu, masukkan nama & surel, maka
itu sudah cukup. Namun jika Anda memiliki blog/website, bisa tambahkan
sebagai kolom isian pilihan (optional) —tidak ditampilkan secara langsung.
Anda bisa menemukan, di mana saja seseorang meninggalkan tanggapan,
termasuk blog yang lainnya. Sehingga menemukan topik-topik yang mungkin
Anda dan orang tersebut memiliki kemiripan untuk didiskusikan (similar interest).
Bagi pemilik profil disqus, Anda bisa melanjutkan komunikasi, bertukar
tanggapan, hanya melalui surel. Sehingga tidak perlu mengunjungi blog & tulisan
terkait lagi, percakapan bisa berlanjut seperti balas membalas surat, namun tetap
terdokumentasi dengan baik di blog tersebut sebagai tanggapan yang saling
bersahutan. Tentu saja ini berarti pemilik blog juga tidak perlu bulak-balik
membuka halaman blognya untuk membalas komentar, cukup via surel dan
membalas setiap tanggapan yang ingin dibalas, bahkan bisa dilakukan sambil
Anda potong rambut di salon dengan push email di ponsel anda!

Mendukung sebagian besar penanda HTML seperti code, pre, a, sup,
strong, em, dan lain sebagainya, walau beberapa tidak didukung seperti
misalnya del (Iha, mengapa juga mencoret kalau bisa dihapus?).

Sistem keamanan yang unik, memiliki sistem keamanan tersendiri untuk serangan
spam, dan juga dukungan komunitas untuk menandai tanggapan-tanggapan yang
tidak santun/sesuai dengan tata krama. Tidak memerlukan CAPTCHA, jadi bagi
yang tidak suka CAPTCHA tidak perlu khawatir. Dapat diintegrasikan dengan
akismet langsung di dashboard disqus. Dan jika Anda suka dengan antispam lain,
mengapa tidak? — saya masih menggunakan Antispam Bee di blog ini.
Pemasangannya mudah dan sederhana, integrasi ke dalam blog tidak
memerlukan keterampilan sebagaimana seorang ahli markah. Cukup
sontek caranya dari halaman panduan pemasangan.
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Memasang Disqus di Website

1. Hal pertama yang harus Anda lakukan jika belum
mendaftar di website

memiliki akun disqus adalah

http://www.disgus.com

DISGUS Home Inbox Discover

e Squid - 13 hours ago
Disqus Team 49 people

Hi
. ﬁ Current Status: HAPPY SAINT PATRICK'S DAY

Happy Saint Patrick's Day Squidites. Have a green beer for me.

Welcome!

Discover great discussions RECENT COMMENTS (129)

or create your own.
’ SideshowSean - a day ago

Take a Tour ‘ Had a White Russian not a good start

39 © ¥ - Viewin Discussion

ABIRFECD &5 ®NOVDEC® - 7hours ago

B Recommended >

4 2 ¥ - Viewin Discussion
n Latest Comments

B Latest Discussions View Discussion Share

$ TOPICS (Coming Soon)
@ Discuss Disqus * 14 hours ago
Disqus Team 79 people

We © Great Discussions and e

Now You Can Too F p

Add Disqus to Your Site
Drop in the world's favorite comment

system for free.

©

Interesting Commenters

Follow people from around the Disqus Network.

' WZ HoF: Corey Graves
KV

Follow

2. Setelah Anda terdaftar, silahkan klik Add Disqus to Your Site yang terletak

di menu setting pojok kanan atas.

3. Isikan form sesuai site profile Anda, lalu klik Finish Registration.

Add Disqus to your site

Site profile H

Site name Please note: “lotusmerah” will be the

primary moderator. If you'd like to use a

Your Site Name different account, please log out first

Choose your unique Disqus URL
Your Unique URL disqus.com
Please use letters, numbers, and hyphens only

This is where you'll access moderation tools and site settings. This
will also become your site's "shortname”.

Category

Please select a category _vj

Finish registration

4. Selanjutnya Anda pilih platform Wordpress. Jika Anda menggunakan
platform lain silahkan lain, Anda hanya perlu menyesuaikannya saja.
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5. Selanjutnya Anda akan masuk ke halaman Install Instruction. Dihalaman ini
terdapat instruksi yang harus kamu lakukan sebelum mengklik Install, yaitu
Anda harus menginstall plugin disqus di Wordpress terlebih dahulu.
Silahkan Login ke Dashboard, pilih menu Plugins > Add New > Search
menggunakan keyword Disqus atau Disqus Comment System

DISOUS For Websites My Home Admin

=- Sholeh's Blog - Settings

General Moderators Filters Advanced Install

SETUP INSTRUCTIONS FOR 7;@@ ‘
Note: These instructions ate for self-hosted Wordpress installations.
In the left panel of your Wordpress admin, select Plugins > Add New
Search for "Disqus” and find the plugin provided by "Disqus™
Select Install Now > Activate Plugin
Proceed with the onscreen install instructions

Log into your Disqus account, then choose the forum shortname you would like 10 install ( 1ozuasmezan )

6. Setelah Anda menginstall dan mengaktifkan plugin Disqus, klik
Configure di menu plugins.

Plugin activated.
All{3) | Active (1) | Inactive (2) | Update Available (1) Search intaled Phigios
Bulk Actions :] Apply 3items
[T Plugin Description
[T Akismet Used by millions. Akismet is quite possibly the best way in the world to protect your blog from comment and trackback spam. It keeps your site
e
Activate Edit Delete protected from spam even while you sleep. To get started: 1) Click the "Activate" link to the left of this description, 2) Sign up for an Akismet API key,

and 3) Go to your Akismet configuration page, and save your APl key.

Version 3.0.4 | By Automattic | View details

O There is a new version of Akismet available. View version 3.1.1 details or update now.
[~ _Disqus Comment System  The Disqus comment system replaces your WordPress comment system with your comments hosted and powered by Disqus. Head over to the
Deactivate Edit Comments admin page to set up your Disqus Comment System.

Version 2.84 | By Disqus | View detalls

[~ Hello Dolly This is not just a plugin, it symbolizes the hope and enthusiasm of an entire generation summed up in two words sung most famously by Louis
Activate Edit Delete Armstrong: Hello, Dolly, When activated you will randomly see a lyric from Hello, Dolly in the upper right of your admin screen on every page.

Version 1.6 | By Matt Mullenweg | View details

[T Plugin Description

Bulk Actions :] Apply 3 items
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7. Selanjut klik Upgrade. Masukkan username dan password Disqus Anda.

Install Disqus Comments

Username or email (don't have a Disqus Profile yet?)
Password (forgot your password?)

8. Pilih website yang tadi Anda buat di Disqus, klik Next

9. Selanjutnya klik Continue to the moderation dashboard.
10. Klik Go to Disqus Moderation. Kini website Anda sudah terintegrasikan dengan Disqus.

Welcome to WordPress. This is your first post. Edit or delete it, then start blogging!

This entry was posted in gorized on Ma3
0 Comments Sheleh's Blog @ iotusmerah
@ Recommend [® Share Sort by Best

Be the first to comment



D. Hindari Penggunaan ALL CAPS pada Judul Post dan Page

Penggunaan All Caps pada Judul Post atau Page memang tidak salah, tapi sangat tidak
dianjurkan penggunaannya oleh pakar usability dan visibility website. Berikut contoh

halaman website yang menggunakan All Caps dan tidak menggunakan All Caps.

e}
.
i o
=
o]
— EEZEER
UPPERCASE CAPITALIZE

Terlihat jelas perbedaannya. Judul yang menggunakan format Capitalize (tidak
all caps) lebih scannable, readable, dan visible sehingga lebih user friendly,
mudah dibaca, nyaman di mata dan mudah dicerna.

Adapun alasan utama Anda harus menghindari penggunaan All Caps pada Judul Post dan

Page adalah:

1. All Caps sulit dipindai oleh mata (scan), sulit dibaca sehingga tidak user friendly.
2. All Caps dalam dunia tulis-menulis berarti ‘berteriak’. All Caps means Shouting!

Kode etik menulis email melarang penggunaan All Caps. Wikipedia juga melarang

penggunaan All Caps dalam penulisan naskahnya.
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E. Hindari Penggunaan Username ‘Admin’

Penggunaan username ‘admin’ sudah terlalu umum digunakan. Oleh karena
itu, sebagai salah satu upaya meningkatkan keamanan website, sebaiknya
ganti dengan username yang tidak mudah diketahui oleh orang lain.

F. Hindari Penggunaan Prefix ‘wp_’ pada Table Database

Alasan menghindari penggunaan prefix ‘wp_’ pada table database adalah sebagai
salah upaya meningkatkan keamanaan website Anda. Perlu diketahui default prefix
database yang digunakan dalam proses instalasi Wordpress adalah ‘wp_’. Ganti prefix
tersebut dengan prefix lain, dianjurkan untuk mengkombinasikan huruf dan angka.
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